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Introduction
I’m excited that I have the opportunity to give you a 
tour of all the new goodies in InDesign CS6! As you will 
discover, there are many additions and improvements in 
this release — truly something for everyone.

There are big, flashy, much-publicized features like 
the new Alternate and Liquid Layouts features and the 
new Content Collector and Content Placer tools. There 
are a number of new improvements to plain ol’ text 
frames. My personal favorite is Auto-Size text frames. 
I’ve already found that this is a feature I will miss greatly 
when I’m forced to work in an earlier version.

There are a wide variety of improvements to exist-
ing features…some big and some small, and a number 
of user interface changes. You will also learn about the 
many new changes for creating EPUB files in InDesign. 
So many of these changes were introduced in CS5.5 and 
then refined in CS6, so I’ve chosen to cover all the new 
stuff that was introduced in CS5.5 and CS6 in this book.

Be sure to read all the way to the end…I’ve saved 
the best for last! In Chapter 5, you’ll learn about the new 
features for authoring interactive PDF forms, right in 
InDesign. This solves a long-standing pain point for any-
one needing to create fillable PDF forms.

I guess I’m a geek, but I always enjoy learning about 
a new release of my favorite program. I hope you enjoy 
it too!

- Keith Gilbert
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1What’s New: 
For Repurposing Content

These features, equally useful for print or screen layout, will help you 

more efficiently reuse content in multiple locations for multiple projects 

for output to multiple media, and help you synchronize content 

between these layouts.
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The problem
The need to reuse the content from one document in 
another is practically a given in the design world. For 
example, you might have a US (Letter) size page that 
you need to reformat for a European (A4) size. Or you 
have a poster that you need to reproduce as a postcard. 
Or a hardcover book that needs to be redesigned as a 
smaller-size trade paperback. These situations happen 
in the print world all the time. Now imagine a day when 
you are designing not only print pages, but screens for 
devices like tablets and smartphones…and all these 
devices have different screen sizes, aspect ratios, and 
resolutions. You need to create the same content for 

all these screens. Not only is this a very difficult 
task, but equally daunting is then trying to keep 
all your multiple versions up to date and in sync 
with each other. Frightening!

This is the problem that Adobe is begin-
ning to address with InDesign CS6. There is a 
whole list of new features to help you more ef-
ficiently reuse content in multiple locations, to 
make content more flexible and adaptable to 
different-size outputs, to help reduce the num-
ber of different InDesign files you create for all 
these different outputs, and to help synchronize 
content between different files. Many of these 
features are equally useful for work destined for 
print or screen.

Alternate Layouts
Previous versions of InDesign allowed you to mix  
multiple page sizes in a single file as well as to divide a 
complex file into multiple sections. The new Alternate 
Layout feature leverages these abilities, allowing you to 
create multiple layouts for different page or screen sizes 
in a single InDesign file. This is fantastic for creating mul-
tiple sizes of a print project or for creating app screens 
for different-size tablets.

To create an alternate layout:

1 In the Pages panel menu, choose Create Alter-
nate Layout, or choose Layout > Create Alternate 
Layout.

2 In the Create Alternate Layout dialog box, enter a 
name for the alternate layout, and choose the cor-
rect source pages.

3 Enter your desired dimensions for width, height, 
and orientation. In the options section, you’ll see 
various choices for how the page content should 
be handled in the alternate layout. Note that you 
can apply Liquid Page Rules, link stories, and con-
trol text reflow. See Figure 1.1. You’ll learn more 
about Liquid Page Rules and content linking in the 
following pages. 

Figure 1.1 The Create Alternate 

Layout dialog box

NEXTprEviNfoCoNTENTS
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4 When you click OK, the alternate layout will be cre-
ated. All the content from the first layout will be 
duplicated in the second layout, according to the 
options set in the Create Alternate Layout dialog 
box. You will need to adjust the formatting of each 
alternate page by hand to make the content fit. But 
the Alternate Layout feature hopefully saved you a 
lot of work copying and pasting, duplicating pages, 
etc. As shown in Figure 1.2, any Paragraph, Charac-
ter, Object, Table, or Cell styles that you had cre-
ated in your first layout are copied into new style 
groups for you. This way, you can leave the para-
graph styles assigned to your text, but adjust type 
sizes and attributes for the styles independently  
for each layout.

5 If you look at the Pages panel, you’ll see that the 
page thumbnails now appear in two columns, with 
the two layouts side by side. You can repeat these 
steps to create a third alternate layout, and so on. 
Note that each layout you create has its own set of 
master pages. Figure 1.3 shows the Pages panel of a 
document with one primary layout and two alter-
nate layouts.

6 When you’re ready to print or export a document 
with alternate layouts, you can choose the alter-
nate layout you wish to print by name, as shown in 
Figure 1.4.

Figure 1.2 When you create an 

alternate layout, you can choose to 

duplicate the styles in each layout in 

a layout-specific style group.

Figure 1.3 A 6 x 9 

document with a 

5 x 5 and a 7 x 8 alternate 

layout. Note the three 

corresponding master 

pages.

Figure 1.4 When printing a document containing alternate 

layouts, you can specify a single layout to print by name.

View an Adobe TV video about 

using alternate layouts at 

http://adobe.ly/IKH1TE.
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7 The drop-down menu available by the name of 
each alternate layout in the Pages panel gives you 
access to certain options related to the alternate 
layout, such as the ability to delete the entire alter-
nate layout or split the window. See Figure 1.5 for an 
example.

Liquid Layout
So now you’re probably thinking “Alternate Layouts 
promise to save me a lot of work setting up and manag-
ing multiple layouts and copy/pasting content between 
them. But could I automate this even more?” The answer 
is yes, you can. For at least some simpler, more tem-
plate-directed layouts, the new Liquid Layout features 
can add further automation to your workflow.

Liquid Layout is intended to help reduce the 
amount of work it takes to reformat pages, or portions 
of pages, for different sizes and aspect ratios. It’s a way 
to bring a form of “responsive design” (that is, design 
that adapts to the media size available) to InDesign 
page layout. It’s ideal for quickly adapting layouts 

between multiple sizes of tablet screens, or creating a 
series of ads at different sizes, or even for reformatting a 
book into a different trim size. There is some configura-
tion and setup involved in Liquid Layout, so it’s particu-
larly beneficial for template-driven, repetitive workflows. 

To use liquid layout, you apply various rules to page 
items that specify how these objects should react (move 
or resize) when you change the page dimensions. You 
test these rules by temporarily tugging on the page 
edges with the Page tool. Once you have the rules es-
tablished, then you either permanently change the page 
size with the Page tool and the Control panel, or create 
an Alternate Layout with a new page size, telling  
InDesign to apply your liquid layout rules as the alter-
nate layout is created.

There are five different liquid layout rules:
 ▶ Scale
 ▶ Re-center
 ▶ Object-based
 ▶ Guide-based
 ▶ Controlled by Master

To apply these rules, select a page with the Page 
tool, and then use the Liquid Page Rule drop-down 
menu in the Control panel, or the Liquid Layout panel, 
or right-click with the Page tool.

A key concept to understand is that the liquid layout 
rules specify how objects relate to the page, not to other 
objects. Let’s examine each liquid layout rule in a little 
more detail.

Figure 1.5 Don’t miss the drop-

down menu available next to each 

alternate layout in the Pages panel.

TIP Give me space
Before testing the liquid layout fea-

ture, it might be useful to make your 

Pasteboard larger using Preferences > 

Pasteboard, so that you have at least 

five inches of pasteboard to the left, 

right, top, and bottom of your page. 

You may need this extra elbow room 

when you wish to quickly preview a 

new page size with the Page tool.
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Scale

The Scale rule is easy to understand. It simply scales all 
the page objects when the page is resized. There are 
two things to keep in mind:

 ▶ All of the page items are scaled, including stroke 
weights and type in frames. In fact, this is the only 
liquid layout rule that ever resizes type. The other 
three rules may change the size of text frames, but 
will never resize the type within the frames.

 ▶ The page items are scaled proportionally, which 
means that if the page size is stretched dispropor-
tionately, white space will be added either above 
and below the page items (referred to as letter-box-
ing), or, as shown in Figure 1.6, beside the page items 
(referred to as pillar-boxing).

Re-center

Re-center is another simple liquid layout rule. When  
Re-center is selected, the page objects are not scaled—
they are just moved to the center of the new page size. 
This isn’t really useful if you need to make the page 
smaller, but if you only want to have the page items land 
in the center of a new larger page size, this is the option 
to choose. 

Object-based

To use the Object-based liquid layout rules, you first 
select a page item with the Page tool. Then you will see 
some new visual indicators appear on the screen. These 
visual indicators are pins, locks, and springs. By clicking 
on these indicators, or by using the checkboxes in the 
Liquid Layout panel, you have a very fine degree of con-
trol over how each page item will react to a change in 
page size:

TIP Quick change
The liquid layout feature uses the 

Page tool intensively. I’d encourage 

you to learn to love the keyboard 

shortcut for this tool (Shift+P), as you 

will find yourself switching to it often 

when using liquid layout.

Figure 1.6 When you disproportionately stretch a page with the Scale liquid layout rule applied, you  

will end up with pillar-boxing, as shown here, or letter-boxing.
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 ▶ Clicking a hollow pin changes it to a solid pin, pin-
ning the object to the edge of the page. This tells 
InDesign to keep the space between the object and 
the page edge static.

 ▶ Clicking a lock inside an object changes the lock to 
a spring. Clicking on a spring changes the spring to 
a lock. A spring specifies that the object can resize in 
that direction. A lock prohibits the object from resiz-
ing in that direction.

So each object will always have three controls in 
each direction, and at most only two of the controls can 
be pinned or locked, because you need to allow some-
thing to “give.” In other words, you can pin an object to 
the left and right edges of the page, but then you need 
to allow the width to resize. Or, you can pin an object to 
the left edge of the page and lock the width of the ob-
ject, but then you must leave the right edge un-pinned. 
See Figure 1.7.

Figure 1.7 Liquid layout object-based rules in action: In the example to the left, I’ve 

pinned the rectangle to the top and right side of the page. I’m allowing the width of 

the rectangle to change, but not the height. When I resize the page (above) with the 

Page tool, the rectangle reacts accordingly—it remains fixed in the same location in 

the upper left corner, and remains the same height, but the width changes.
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Guide-based

There are now two kinds of guides in InDesign: regular 
ruler guides, and liquid guides. To create a liquid guide, 
you drag a guide out of either ruler with the Page tool. 
Or, you can create a regular guide, and then click the 
small icon that adorns the left or top edge of the guide 
shown in Figure 1.8.

Figure 1.8 To switch from a regular ruler guide to a liquid guide, click the small 

icon on the left or top end of a ruler guide.

When the Guide-based liquid layout rule is ap-
plied to a page, by default nothing happens when you 
change the page size. But check this out: When you 
drag out a horizontal liquid guide, and this special type 
of guide touches a page object, then the height of the 
object will change with the page size. If an object inter-
sects with a vertical liquid guide, then the width of the 
object will change with the page size, as demonstrated 
in Figure 1.9.

 TIP One tool 
to rule them all
One reason that the liquid layout 

rules are applied with the Page tool 

is to reinforce the idea that the rules 

are page-based. All the objects on 

a page must follow the same liquid 

layout rule.
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One interface behavior that takes some getting used to 
is that you can create and move liquid guides with the 
Page tool, but you can’t select and delete guides with 
the Page tool by just clicking on them. To select a liquid 
guide with the Page tool, you must Command-click 
(Mac) or Ctrl-click (Windows) on the guide using the 
Page tool.

Figure 1.9 In the example at left, both squares are touched by a horizontal 

guide, and only the left square is touched by a vertical guide. So when the 

page is resized (above), the height of both squares changes, but only the left 

square changes in width.

Controlled by Master

The final liquid layout rule is Controlled by Master, which 
simply applies whatever rule is used by the currently 
applied master page to the document page when the 
page is resized. If this option isn’t selected, you can have 
one liquid layout rule that affects the master page  
objects, and another rule that affects the document 
page objects.
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Once you have applied one of the liquid layout rules 
with the Page tool, you can use the Page tool to grab the 
corner or side handles of the page and drag to see how 
the page objects react to changes in page size. When 
you release the mouse, the page snaps back to the origi-
nal size. If you want to resize a page permanently with 
the Page tool, just Option/Alt-drag the edge of the page.

You may notice that in the Layout menu, liquid lay-
out has replaced the Layout Adjustment menu option. 
If you still want to use the Layout Adjustment feature, it 
can still be turned on in the Layout > Margins and Col-
umns dialog box, or in the Liquid Layout panel menu. 
However, this feature cannot be applied at the same 
time as liquid layout rules.

When using liquid layout to create new document 
sizes, there are two other particularly useful features: 
flexible-width columns (described on page 21) and 
Auto-fit for images (introduced in CS5). If you have Auto-
fit selected for an image, then as the image frame grows 
and shrinks, InDesign will resize the image with the 
frame. If the frame is scaled disproportionately, the con-
tent will maintain its proportions. 

Linked Content
Kind of like the “soft launch” of a new restaurant or retail 
store, Adobe quietly added Linked Content to CS5.5, but 
didn’t say much about it. Now, in CS6, they’ve polished 
the feature and are holding the Linked Content grand 

opening. This feature allows you to have “parent” con-
tent that is linked to “child” content that can appear in 
several places in a single document, or spread across 
several documents. When parent content is edited, you 
are given the option to update the content in all the 
other locations.

This is a pretty simple concept. But the complexity 
increases when you edit the content or appearance of 
some of the child text or one of the child objects. When 
the parent text or object is later edited, what should 
happen to the edits that you made to the child text or 
objects? As we will see, some of these local edits can be 
preserved, and some will be stripped out when the par-
ent text or object is edited.

It’s worth clarifying one term right at the start.  
InDesign has always allowed you to create a set of two 
or more frames whose content flows from one to the 
other. Some people refer to these as linked frames, but 
the correct term is “threaded” frames. I’m going to re-
serve the term “linked” frames here to mean two or more 
text frames that have a parent-child relationship. When 
you change the content or appearance of the parent, 
the content and appearance of the child changes also.

Three types of content-linking are possible in CS6:

 ▶ Story linking
 ▶ Object linking
 ▶ A combination of Story and Object Linking

View Adobe TV videos about 

using Liquid Layout at 

http://adobe.ly/I8O5ay and 

http://adobe.ly/HWmsSJ.
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To create a linked story:

1 Click inside a story with the Type tool, and choose 
Edit > Place and Link.

2 You will be switched to the Content Placer tool, 
and the loaded place cursor will appear. Click or 
drag where you want the linked text to go. A new 
“child” frame will be created. If you have frame 
edges showing, you’ll see a small blue “link” indi-
cator in the upper left corner of each child frame 
you create. The linked text can be put on the same 

TIP Link control
Regular placed images also display 

a blue link icon in their upper left 

corner. If you hover over this icon, 

the filename of the linked file will be 

displayed. If you Option/Alt-click the 

icon, the Links panel will open. If you 

don’t want this icon to display at all, 

then choose View > Extras > Hide 

Link Badge.

Figure 1.10 Two linked text frames, the parent on the left, and the child 

on the right

Figure 1.11 When the parent text or formatting changes, the child text 

frame will display a yellow warning symbol in the upper left corner.

page, on another page of the same document, or 
in another open document. The text frames for the 
linked text frames can be different sizes, and have 
different appearances. See Figure 1.10.

3 If you change the text in the parent frame, a yellow 
warning symbol appears in the upper left corner of  
the child frame (as shown in Figure 1.11), and also in 
the Links panel. If you want the child text to update 
to match the parent text, click the warning icon.
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